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New Features
New Features
Campus Manager Release 3.2 has the following new features: 

• Support for new devices (For more information on supported devices 
refer“Supported Devices” section on page 3)

• Path Analysis provides Layer 2 support for HSRP

• Multiple sort feature in User Tracking

Campus Manager 3.2 Documentation

Note Although every effort has been made to validate the accuracy of the information 
in the printed and electronic documentation, you should also review the Campus 
Manager documentation on Cisco.com for any updates.

The following documents are provided in PDF on your product CD:

• Installation and Setup Guide for Campus Manager 3.2 on Solaris

• User Guide for Campus Manager

Note Adobe Acrobat Reader 4.0 is required.

Use these publications to learn how to install and use Campus Manager 3.2 
(CiscoWorks2000):

• User Guide for Campus Manager (DOC-7813973=)—Provides information 
about the use and operation of Campus Manager, including application 
descriptions, scenarios, and troubleshooting. This publication is available in 
PDF format on CD-ROM and from Cisco.com.

• Installation and Setup Guide for Campus Manager 3.2 on Solaris 
(DOC-7813985=)— Provides information about Campus Manager 
installation requirements and procedures on Windows 2000. This publication 
is available in PDF format on CD-ROM and from Cisco.com.
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Supported Devices
• User Guide for CiscoWorks2000 Server (DOC-7814072=)—Provides 
information about setting up, administrating, and diagnosing the 
CiscoWorks2000 Server, including the ANI Server.

• Installation and Setup Guide for CD One on Solaris 
(DOC-7814069=)—Provides information about CD One installation 
requirements and procedures on Windows 2000. This publication is available 
in PDF format on CD-ROM and from Cisco.com.

• Release Notes for CD One, 5th Edition on Solaris (78-14071-01)—Provides a 
list of known problems for the CiscoWorks2000 CD One, 5th Edition 
software.

• Campus Manager online help— Provides task-oriented and context-sensitive 
help from every window that contains a Help button and includes all of the 
information available in the User Guide for Campus Manager. This ensures 
you have complete information even if you do not have the manual readily 
available while using Campus Manager. 

Supported Devices
Device packages for all supported devices are installed when you install Campus 
Manager. Campus Manager 3.2 supports all devices supported in Campus 
Manager 3.1, plus additional devices. 

For a list of devices supported in Campus Manager 3.2, refer to the following 
URL:

http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/
camp_mgr/sup_dev/cm_3_2.htm

Support Information
Campus Manager 3.2 supports only US-English and Japanese versions of the 
Solaris OS. Set the default locale to US-English for US-English version and 
Japanese EUC for Japanese version. 
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Known Problems
Known Problems
Known problems (bugs) in Campus Manager 3.2 are graded according to severity 
level. These release notes contain descriptions of:

• All severity level 1 or 2 bugs.

• Significant severity level 3 bugs.

• All customer-found bugs (regardless of severity level).

You can search for problems using the Cisco Software Bug Toolkit. To access the 
Software Bug Toolkit:

Step 1 Log into Cisco.com.

Step 2 Select Service & Support> Technical Support Help—Cisco TAC > Tool Index.

Step 3 In the Jump to: links at the top of the page, click the letter S, then select Software 
Bug Toolkit.

You can also access the Software Bug Toolkit by entering the following URL in 
your web browser:

http://www.cisco.com/cgi-bin/Support/Bugtool/home.pl.

Note If an operation does not work, open the Java Console. The Java Console reports 
any Java errors, but slows performance of Java applications. For detailed 
instructions on opening the Java Console, as well as a listing of which versions of 
the Java Plug-in Campus Manager 3.2 supports, refer to the CD One, 5th Edition 
Release Notes.

This section contains notes and caveats for Campus Manager 3.2, as follows:

• General Notes and Known Problems, page 5

• Netscape Navigator Known Problems, page 12

• Path Analysis Known Problems, page 13

• User Tracking Known Problems, page 23

• Topology Services Known Problems, page 29
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Known Problems
• Resolved Problems, page 38

Note Refer to the General Known Problems and the Server, Browser, and Desktop 
Known Problems sections of the Release Notes for CiscoWorks2000 CD One, 5th 
Edition for additional ANI Server-related known problems.

General Notes and Known Problems
Note the following:

• Your browser must be properly configured. If it is not properly configured, 
Campus Manager might not work correctly. Refer to the Installation and 
Setup Guide for CD One on Solaris for information on properly setting up 
client systems.

• Campus Manager requires a DNS server to function properly. Many 
commands operate erratically or not at all if there is no DNS server on the 
network.

• Running Campus Manager from a browser invoked from an x-window 
connection is not supported. Install a browser on the client from which you 
wish to connect.

• Virus checker applications on Windows NT and Windows 2000 systems 
might slow Campus response times.

• You can upgrade your operating system (OS) either before or after you 
upgrade Campus Manager. However, if you upgrade the OS after upgrading 
Campus Manager, you will not receive any OS-related patch warnings or 
service pack-related warnings.

• Verify that the latest version of all required OS patches, service packs, and 
third-party device drivers are installed before proceeding with an OS 
upgrade.

• It is recommended that any Windows 2000 server running Netscape 
Navigator should not also be used as a client.

• Visio Caveats:

– It is recommended that you do not export an entire topology map to Visio. 
Instead, select and export particular devices or a segment of the network.
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Known Problems
– After selecting Export to Visio, be sure to enter a filename in the Export 
to Visio dialog box for the file Visio will generate.

– Before opening a topology map exported to Visio, you need to download 
the cm_cisco.vss file and place it in the Visio/Solutions directory.

– When opening a topology map exported to Visio, select the comma (,) as 
the delimiter to use.
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Known Problems
General Known Problems
Table 1 General Known Problems

Bug ID Summary Explanation

None Catalyst 3500 series is supported 
in IP mode only.

Campus Manager supports Catalyst 3500 series in 
IP mode only. Cluster mode is not supported. If 
your network has a Catalyst 3500 in cluster mode, 
the links display incorrectly.

Workaround:

None.

CSCdm77812 Non-empty CLASSPATH 
environment variable might 
produce erratic browser 
behavior.

If your system has a non-empty CLASSPATH 
environment variable, your browser might behave 
unpredictably (for example, returning a 
ClassNotFound Exception for no apparent 
reason).

Workaround:

Unset CLASSPATH variable non globally:

• Solaris—unset CLASSPATH variable from 
terminal window from which you launch 
browser.

• Windows NT—unset CLASSPATH variable in 
MS-DOS prompt window and launch browser 
from the prompt.

CSCdm83204 Campus Manager applications 
do not work when 
CiscoWorks2000 is accessed 
using http://localhost:1741.

If you access CiscoWorks2000 applications using 
http://localhost:1741 from browser on same 
machine CiscoWorks2000 server is installed on, 
Campus Manager suite of applications will not 
work.

Workaround:

Use full DNS name or IP address of server, even 
when accessing it locally.
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CSCdm88520 Minimized windows do not 
become visible when selected 
from a Window menu.

If a window is minimized, you cannot make it 
visible by selecting it from a Window menu. 

Workaround: 

• On Solaris, double-click icon of window on 
desktop.

• On NT, click icon of window in task bar.

CSCdp48040 When you attempt to launch an 
application, the message 
Application already running 
displays, where application is 
the name of the application you 
attempted to launch.

If you close application window and Loading Files 
popup window while application is loading, this 
message is displayed. Problem occurs because 
browser is still loading files. 

Workaround:

Close all browser windows, then start application 
again.

CSCdp74251 Application performance very 
slow with HTTP proxy.

Accessing Campus Manager via HTTP proxy 
might cause significant performance degradation.

Workaround:

Access CiscoWorks2000 Server directly from 
client.

CSCdr85739 Logging out of CiscoWorks2000 
does not log user out of Campus 
Manager.

If you click Logout in the CiscoWorks2000 Main 
Window, you are logged out of all applications 
except for Campus Manager. Thus, you can still 
add and delete VLANs, as well as look at topology 
layouts. 

Workaround:

Close all topology windows after logging out of 
CiscoWorks2000.

Table 1 General Known Problems (continued)

Bug ID Summary Explanation
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CSCds05957 Gatekeeper configuration file 
must be modified in order to run 
Campus Manager 3.1 on 
multi-homed machines.

Campus Manager 3.1 is supported by multi-homed 
machines (machines with multiple NIC cards, 
each configured with different IP addresses). 
Owing to CORBA restrictions, only one IP 
address can be used by client to access 
CiscoWorks2000 Server.

Workaround:

To ensure Campus Manager runs properly on 
multi-homed machines, open gatekeeper 
configuration file and enter appropriate IP address 
in the following fields: 
vbroker.gatekeeper.backcompat.callback.host=
<external-IP-address>
vbroker.se.exterior.host=<external-IP-address>
vbroker.se.iiop_tp.host=<external-IP-address>
vbroker.se.interior.host=<external-IP-address>

CSCds88388 Cannot launch CiscoView on an 
IGX series device.

The following procedure results in this problem:

1. Launch Topology Services.

2. Open LAN Edge view.

3. Right-click on IGX series device and select 
CiscoView from context menu.

4. A dialog box appears. Enter appropriate 
community strings, and CiscoView attempts 
to launch, but error message is displayed.

Workaround:

Launch CiscoView on IGX series devices via 
Cisco WAN Manager.

Table 1 General Known Problems (continued)

Bug ID Summary Explanation
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CSCdt19019 CiscoWorks2000 sessions do not 
timeout with Campus Manager 
running.

As long as Campus Manager is running, you are 
not logged out of current CiscoWorks2000 
session, even if idle for a few hours.

Workaround:

Log out of CiscoWorks2000 after using Campus 
Manager.

CSCdt22462 Download of Java applets on 
Windows 2000 machines may 
take longer than expected if virus 
checker application is enabled.

On some Windows 2000 systems, the initial 
download of large Java applets (or subsequent 
downloads of the same applets that are not cached 
locally) might take longer than expected (up to six 
minutes in some instances). After the applet has 
been loaded and cached locally, the problem no 
longer occurs.

The delay is caused by client side filtering 
mechanisms such as virus scanning. Some virus 
scanners are configured to automatically scan 
content downloaded by browsers. Scanning 
consumes a lot of memory and results in disk 
paging on most systems.

Owing to this, downloading is significantly slower 
than expected. (The effect is less on systems with 
large amounts of RAM and virtual memory.)

Workaround:

Disable the automatic scanning of all downloaded 
files, and instead enable the scanning of program 
files only (specified by file extension).

Exact instructions vary depending on the virus 
scanner installed on your system.

Table 1 General Known Problems (continued)

Bug ID Summary Explanation
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CSCdt42318 Unable to copy and paste IP 
addresses from Topology 
Services to Path Analysis when 
keyboard shortcuts are used.

The following actions result in a problem:

1. After selecting an IP address in Topology 
Services, type Ctrl+C to copy address.

2. With cursor active in Path Analysis “From” 
field, type Ctrl+V; the following is pasted in 
instead of IP address: 
java.lang.nullPointerException

Ctrl+X, Ctrl+C, and Ctrl+V (keyboard shortcuts 
for cut, copy, and paste commands) are not 
supported by summary tables in the Topology 
Services main window or most tables displayed by 
Campus Manager applications.

Also, in applications that support the copying of 
table cells by selecting Edit > Copy, a carriage 
return is added to the end of the last cell copied.

Workaround:

None

CSCdt55303 Launching a Campus Manager 
application with the Print dialog 
box open in another Campus 
Manager application results in 
error.

The following actions result in a problem:

1. Select Print from active Campus Manager 
application.

2. With Print dialog box displayed, launch 
another Campus Manager application. New 
application window does not respond to user 
input.

Workaround:

Close the Print dialog box and relaunch 
application.

Table 1 General Known Problems (continued)

Bug ID Summary Explanation
11
Release Notes for Campus Manager 3.2 on Solaris

78-14011-02



 

Known Problems
Netscape Navigator Known Problems

Table 2 Netscape Navigator Known Problems

ID Summary Explanation

CSCdp43999 Maps and configuration dialogs 
display offset menus and list 
boxes in Netscape on a Solaris 
client.

Sometimes, when a map or a configuration dialog 
is launched, menus or list boxes are not displayed 
below the menu. This offset occurs in Navigator 
on a Solaris client.

Workaround:

Move or resize window.

CSCdt11838 You are not prompted to install 
the Java plug-in when launching 
an application that utilizes the 
plug-in for the first time.

If RealJukebox Plug-in for Navigator is already 
installed on a Windows client before the first 
launch of application utilizing Java Plug-in, you 
will not be prompted to install Java Plug-in.

Workaround:

Uninstall RealJukebox Plug-in. Another option is 
to rename nprjplug.dll file in Navigator Plug-ins 
directory with new extension—for example, 
nprjplug.dll.bak.

After Java Plug-in is installed, you can reactivate 
RealJukebox Plug-in by changing renamed file 
back to nprjplug.dll.
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Path Analysis Known Problems

Table 3 Path Analysis Known Problems

ID Summary Explanation

CSCds70102 Layer 2 is missing from a trace 
run on devices connected by a 
Fast Ethernet Channel or a 
Gigabit Ethernet Channel.

When a trace is run on two devices connected by a 
Fast Ethernet Channel or a Gigabit Ethernet 
Channel, Path Analysis main table displays 
interface type as Unknown even though devices are 
in a managed state.

Workaround:

None.

CSCds77376 Path Analysis does not accept 
hostnames in the /etc/hosts file 
as source or destination seeds, 
causing traces to fail.

Following actions result in the problem:

1. Enter a device name from /etc/hosts file. 

2. Run a discovery.

3. Set the selected device as Source and run a 
path trace. Path Analysis displays following 
message: Trace Aborted. 

Path Analysis requires DNS, NIS, or NIS+ to look 
up hostnames in /etc/hosts file.

CSCds77438 Path Analysis Map tab does not 
refresh properly.

This problem is mainly observed when running 
both client and server on same machine. It occurs 
after running a large number of Path traces on 
client browser.

Work around:

Close browser and relaunch Campus Manager.

Note We recommend that you run client and 
server on different machines. Doing so 
does not eliminate problem, but does limit 
its occurrence because you need to run a 
large number of traces before problem 
manifests itself.
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CSCds77461 Call Detail Records (CDR) 
query results are sometimes 
displayed after pressing Cancel.

Multiple threads are launched to query every 
Cisco CallManager for information specified in 
user's CDR query. Since all query activities can 
take a second or two to cancel, query results are 
sometimes displayed even after pressing Cancel.

Workaround:

None.

CSCds79693 Voice trace query results are 
always displayed using local 
time zone. 

Local time zone always displayed in voice trace 
query results, even if user selects GMT time zone 
when specifying call start time. 

Workaround:

None.

Table 3 Path Analysis Known Problems (continued)

ID Summary Explanation
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CSCds92510 ICS 7750 device running Cisco 
CallManager does not appear in 
list of Cisco call managers.

To verify that software is installed and configured 
correctly, open web browser and navigate to 
following URL:
http://hostname/ccn/clusterinfo.asp.
One line of alphanumeric characters should be 
displayed. 

If software is installed and configured correctly, 
then the problem occurred because ccmStatus 
cannot be retrieved via SNMP from ICS 7750 
device (both primary and secondary SBC).

By default, log tracing is disabled for performance 
reasons when System Manager and Cisco 
CallManager are both installed on device. Since 
log tracing is disabled, you cannot retrieve 
ccmStatus with SNMP.

Workaround:

Manually enable tracing through Cisco 
CallManager:

1. Ensure SDI Trace settings are as follows: 

– User Mask: 11 

– Level: ERROR 

– Event: INFORMATION

2. For SNMP agent to work, enable: 

– EnableSNMP in CCM Service 
Parameters.

– Trace On in CCM Trace Configuration.

Table 3 Path Analysis Known Problems (continued)

ID Summary Explanation
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CSCds92510 
(continued)

ICS 7750 device running Cisco 
CallManager does not appear in 
list of Cisco call managers.

3. Restart SPE through System Manager: 

a. Enter following URL in browser: 
\\ip_address\icsconfig 

b. Click Shutdown/Restart link.

c. Click Restart for Primary SPE in list.

Note On dual SPE systems, this will trigger 
a failover. But when procedure is 
repeated to restart secondary SPE, box 
will switch back to primary SPE.

See CSCds07414 and CSCdt54829 for more 
information.

CSCdt04978 Highlighted path trace in 
Topology Services map may be 
difficult to view.

It may be difficult to view highlighted path trace 
in Topology Services map, especially if “Fit to 
Window” view is selected.

Workaround:

Zoom into Topology Services Map view by 
selecting Select All Highlighted Objects > Zoom 
to Selected. 

Table 3 Path Analysis Known Problems (continued)

ID Summary Explanation
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CSCdt16279 Uninformative or confusing 
error message displayed in Voice 
Trace Query Status tab after 
running CDR query.

Status tab of Voice Trace Query window may 
display uninformative error message. For 
example:

Error querying CCM noname
Probable cause
noname

Workaround: 

1. Verify that CCM machine is accessible by 
pinging it from your Campus Manager server. 

2. If CCM host is accessible, then verify that 
web server is running. Open web browser and 
navigate to the following URL: 
http://ccm_ip_address/ccn/cdr.asp?type
=all 

3. If web server is running, you will see a 
response to your URL request in browser 
window. Response may provide more detailed 
diagnostic information to troubleshoot 
problem: 

a. If web browser response indicates 
database query error, contact TAC for 
help in diagnosing this CCM database 
layer problem. 

b. If 404 Not Found error message is 
displayed, web server is probably 
running, but ASP script that queries CDR 
records cannot be located—ensure that 
Cisco CallManager Serviceability 
software is installed on this CCM. 

c. If The page cannot be displayed error 
message is displayed, then web server 
may not be running—start it on CCM 
host.

Table 3 Path Analysis Known Problems (continued)

ID Summary Explanation
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CSCdt42404 Trace tab displays GMT as time 
zone, even though server is set to 
local time zone.

A number of Java bugs involve incorrect 
interpretation of time zones. Usually, the correct 
time zone is displayed if local time zone is set to 
appropriate three-letter abbreviation—for 
example, PST for Pacific Standard Time.

This problem is observed on Solaris clients with 
TZ environment variable set to 
"American/Tijuana." 

Workaround:

If TZ environment variable is instead set to 
"PST8PDT," then Java interprets local time zone 
correctly.

CSCdt42600 To and From fields may not 
function properly after selecting 
Print in Path Analysis. 

This problem is caused by Java Virtual Machine 
bug. After selecting Print in Path Analysis, "To" 
and "From" fields may not accept mouse focus, or 
focus may appear in both fields simultaneously. 

Workaround:

Resize Java console window. If problem persists, 
close Path Analysis window and open another 
window. 

CSCdv70125 Path Analysis does not perform 
layer 2 traces when 
IfType=unknown.

Path Analysis tool fails to get the Layer 2 path 
trace for Layer 2 devices. It lists 
(IfType=unknown) for both L2 devices across the 
trace. 

Workaround: None.

Table 3 Path Analysis Known Problems (continued)

ID Summary Explanation
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CSCdw03315 Path Analysis fails to show layer 
2 for RFC 1918 address 
endstations.

Cisco Enterprise Solutions Engineering 
recommends (AVVID solution architecture 
recommendations) that customers use RFC 1918 
private addressing for IP Phones (to conserve 
public address space). 

In such a situation, where the network devices use 
one address space for their management addresses 
(sc0 on switches, etc.), but endstations use a 
different (private) address space (such as 
10.x.x.x), path is unable to provide layer 2 
information.

Workaround: 

None.

CSCdw03353 Path Analysis fails for certain 
configurations of DSBU 
switches.

Path Analysis fails to show layer 2 information for 
certain configurations of DSBU switches (cat 
2900XL, 3500XL) due to differences in mib 
instrumentation for VLAN information (as 
compared to mainstream Cat models 4K, 5K, 6K, 
etc.). 

For example, a customer might prefer to have a 
single VLAN going to the access-layer switch (cat 
3500XL), and in that situation it is possible that 
customer will do minimum configuration on that 
switch and leave all ports in default VLAN 1.

However on an upstream Distribution layer 
switch, it is possible that the port connecting to the 
3500 is in a different VLAN (66 or whatever). Path 
Analysis apparently gets confused by this and fails 
to show layer 2 info.

Workaround: 

None.

Table 3 Path Analysis Known Problems (continued)

ID Summary Explanation
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CSCdw03370 Path Analysis does not cope well 
with multiple paths.

Path Analysis needs to give better information in 
situations where there are multiple paths (Cisco 
recommends redundant architectures to 
customers, after all). Path Analysis may show 
correctly that there are multiple paths, but the 
manner of displaying this is confusing, and the 
accompanying messages (path is too complex) are 
not of much help to the user. 

Also, when there are multiple paths, in cases 
where both paths are used (such as equal cost eigrp 
scenarios) there may be routing information that 
causes one path to be favored, but Path Analysis 
does not appear to be aware of this.

Workaround: 

None.

CSCdw03400 Path trace needs to give better 
information when trace fails.

Path trace gives little or no information when trace 
fails. This severely limits the usefulness of the tool 
for troubleshooting. Path Analysis needs to 
provide better information to user on the reasons 
for trace failures.

Workaround: 

None.

Table 3 Path Analysis Known Problems (continued)

ID Summary Explanation
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CSCdw03410 Path Voice Trace does not 
consider transcoding points.

Current Campus Path Analysis Voice Trace is 
valid only in the case where the two endpoints are 
IP Phones registered with the same CCM cluster. 
For other cases (involving transcoding), Path does 
not know how to get correct path info. 

Examples: 

• Phone call from IP phone to POTS phone off 
H.323 gateway (e.g. 3640) 

• Phone call from one CCM cluster to another 
(where path would be from phone 1 to CCM 
1, then from CCM 1 to CCM 2 via H.323 
inter-cluster trunk, then from CCM 2 to phone 
2) 

• Phone call to gateway (PSTN, analog, etc.) 

• Phone call to other servers (voicemail, 
conference, etc.)

This is a very complex issue, and most likely will 
require new instrumentation from telephony 
servers, etc.

Workaround: 

None.

Table 3 Path Analysis Known Problems (continued)

ID Summary Explanation
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CSCdw15555 Voice trace fails to get CCM 
cluster information if CCM 
HTTPD shuts down.

Campus Path Analysis Voice Trace needs to query 
call managers known to ANI in order to see what 
cluster membership is. 

This is done via a HTTP query 
http://ccm-name/ccn/clusterinfo.asp

EVVBU recommends customers to disable the 
webserver on all cluster members except one, as a 
security precaution (because they use IIS, and can 
be badly damaged by viruses such as Code Red 
and NIMDA). If cluster members have webserver 
shut off, then Path cannot get information on 
cluster membership and cannot retrieve CDRs. 

Workaround: 

Turn the webserver on the CCM back on.

CSCdw36518 Layer2 not shown between 
switches in different VTP 
Domains.

When a trace is done between switches lying in 
different VTP domains, Layer2Trace will not be 
shown.

Workaround:

None.

CSCdw37811 PATH: Ifindex empty when 
traced to AP340 or AP350.

IfIndex will not be shown properly for 
AP340/AP350 

Workaround:

None

CSCin00624 PATH:Ifindex empty after trace 
-- HSRP.

IfIndex may be empty after performing a trace 
involving HSRP router 

Workaround: 

None

Table 3 Path Analysis Known Problems (continued)

ID Summary Explanation
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User Tracking Known Problems
Information displayed in a row might not reflect the most current network state. 
Because User Tracking discovery takes information from routers and switches, 
which collect their information at different times, the information in a row reflects 
the state of the network or subnet at the time displayed in the Last Seen field.

Table 4 User Tracking Known Problems

ID Summary Explanation

None User Tracking discovery could 
span more than desired subnet.

When you start subnet discovery of user nodes, 
devices in that subnet are marked for discovery. 
Since switches support multiple VLANs, 
discovery could span more than the desired 
subnet. User Tracking could discover additional 
end host nodes not in selected subnet. 

Workaround:

None.

CSCdk20561 Catalyst 3000 devices shown as 
multiple host entries with same 
MAC addresses but different 
VLAN information, causing 
duplicate entries after each User 
Tracking discovery.

Catalyst 3000 devices appear as multiple host 
entries with same MAC addresses but different 
VLAN information, causing duplicate entries after 
each User Tracking discovery.

Workaround:

None.

CSCdp83349 Cannot run User Tracking 
through command line without 
setting DISPLAY environment 
variable.

DISPLAY environment variable must be set in 
order to run User Tracking through command line 
or standalone mode. 

Workaround:

None.
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CSCdr45212 IP phone table does not display 
SoftPhone entries.

SNMP agent in Cisco CallManager 3.0 does not 
report any SoftPhone entries. Thus, User Tracking 
will not display SoftPhone entries in IP phone 
table. 

See CSCdr55949 for more information.

Workaround:

None.

CSCdr53022 Cisco CallManagers are not 
discovered if there are CDP 
devices connected to the same 
hub.

When Cisco CallManager (or host or IP phone) 
and CDP device are connected to same hub, User 
Tracking cannot discover that Cisco CallManager.

Workaround:

None.

CSCdr85384 Phone entries displayed by User 
Tracking differ from entries 
displayed by Cisco CallManager.

User Tracking phone entries acquired via SNMP 
for each Cisco CallManager may be different from 
entries in Cisco CallManager.

Cisco CallManager database displays historical 
record of all phones registered to Cisco 
CallManager. SNMP agent retains only record of 
phones registered since agent was started, 
accounting for differences.

Workaround:

None.

CSCds01217 Change in IP phone directory 
number is not recognized by 
User Tracking.

When IP phone directory number is added, 
deleted, or changed, you must restart Cisco 
CallManager before User Tracking recognizes 
changes.

See CSCdr55953 for more information. 

Workaround:

None.

Table 4 User Tracking Known Problems (continued)

ID Summary Explanation
24
Release Notes for Campus Manager 3.2 on Solaris

78-14011-02



 

Known Problems
CSCds81070 IP phone entry in User Tracking 
main table may not have subnet 
information.

When User Tracking discovers MAC entry 
belonging to network IP phone but is not able to 
find corresponding ARP (from router) to resolve 
its MAC to IP address, User Tracking attempts to 
match IP address with entries from phone table. 
When this happens, subnet information will be 
missing from phone entry. 

Workaround:

None.

CSCdt06183 User Tracking main table may 
not display all entries displayed 
in phone table.

User Tracking entries shown in main table are 
discovered from network, whereas User Tracking 
entries shown in phone table are read from Cisco 
CallManager. 

If User Tracking cannot discover particular 
phones in network, entries for those phones in 
User Tracking phone table will not have device 
and port information. 

Workaround:

None.

CSCdt25525 User Tracking main table 
sometimes displays 
CDP-enabled devices that are 
outside of ANI discovery 
boundary.

During User Tracking discovery, User Tracking 
reads entries from CAM table, which may include 
MAC addresses of devices that fall outside of ANI 
discovery boundary.

Workaround:

None.
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CSCdt42619 Unable to save changes using 
keyboard shortcut (Ctrl+S).

After modifying a cell, if you use keyboard 
shortcut (Ctrl+S) with cursor in editable cell, 
changes are not saved. Problem also occurs if you 
use any shortcut involving Ctrl key and then select 
File > Save Changes.

Workaround:

Do not use any keyboard shortcuts involving Ctrl 
key when the cursor is in a editable cell.

CSCdt74810 User Tracking, running on 
HP-UX clients, unable to load 
and display 30,000 rows in main 
table.

By default, User Tracking, running on HP-UX 
clients, can load and display up to 20,000 rows in 
main table.

Workaround:

To enable User Tracking to load and display up to 
40,000 rows in User Tracking main table, specify 
Java Virtual Machine (JVM) run-time parameters 
to use more memory. 

1. Launch Java Plug-in control panel.

2. In Run Time Parameters field, enter-mx128m.

3. Click Apply.

CSCdv17242 Printing User Tracking entries to 
a printer does not work if the 
client is a Windows2000 
platform.

This is because Java Plug-in for Windows2000 can 
generate hundreds of MB for the print job. Java 
Plug-in converts the print job to graphics 
(Postscript) format. For User Tracking with 250 
entries, if the client is an NT 4.0 box, then the print 
job would be around 50MB. 

If the client is a Windows2000 box, then the print 
job is more than 160MB. Most printers may not 
have enough memory or spooler space to hold 
huge print jobs. It may take a long time to print. 

Workaround: 

Try to export User Tracking to a .txt file and then 
use Excel to print it out.
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CSCdw04486 User Tracking does not work for 
C2950 versions <12.0(5) WC2.

In the catalyst 2950 version releases 12.0*WC(1), 
an agent bug CSCdu88701 has been filed.

This states that an ‘agent skips rows in 
snmpgetnext request of dot1dTpFdbTable’.
Hence, User Tracking will not be able to show up 
end hosts connected to this version of the device.

Workaround:

This has been fixed in the 12.0(5)WC2 release. 
Upgrade to this version.

CSCdw04499 User Tracking does not work for 
C3550 versions up to 12.1(6) 
EA1.

User Tracking does not work for 3550 XL version 
releases 12.1(4)EA1 and 12.1(6)EA1. This is due 
to an agent bug CSCdu55510. This states that 
there is ‘No access to second STP instance using 
community instance index.’.

Hence, User Tracking will not be able to show up 
end hosts connected to the devices which run the 
above releases. 

Workaround:

It has been fixed in the 12.1(6)EA1a release. 
Upgrade to this version.

CSCin00181 Last seen field gets updated for 
disconnected ip phones.

The Last Seen in Phone Tracking corresponds 
only to Last Seen on CCM and not to Last Seen on 
Network.

Workaround: 

None.

CSCdw09818 VLANE: Port attribute shows 
incorrect information.

This problem is observed only with down ports, 
and the mib values returned by the devices seem to 
latch on the previous up speed and duplex.This is 
a problem in the agent side.

Workaround: 

None.
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CSCdw13857 UT does not work for C4224 
devices.

This is caused by the agent not supporting 
VLAN-indexing for the BRIDGE-MIB. Hence the 
end hosts/phones connected to this device will not 
be shown up in the UT table.

Workaround: 

None.

CSCdw15109 UT does not recognize VLAN 
change to default-VLAN.

When a switch port is moved from an externally 
reachable VLAN to an unreachable VLAN, User 
Tracking will not recognize the change in VLAN.

Workaround: 

None.

CSCin00363 End host is not showing if 
obsolete ANI device IP address 
is assigned.

If a CDP device is connected to the port and then 
a new end host is added, the new end host will not 
be learnt because ANI is not aware of such a 
change. 

Workaround: 

Delete the specific device and then do a ANI 
device specific discovery, followed by UT 
discovery.

CSCin00365 A Change of CCM registration 
adds a new record in phone table.

CCM entries themselves respond with two entries. 
The change should be done in the CCM and not in 
the UT.

Workaround: 

None

CSCdw44519 UTLite should, but does not, 
support all Windows clients.

UTLite does not work for Windows 98 clients. 

Workaround:

None.
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Topology Services Known Problems

CSCin06554 UT: Discover Subnet field empty 
sometimes.

UT: Discover Subnet field would be empty 
sometimes. Initially it will have a list of all the 
discovered subnets. However, after the last 
discovery (for example, discovery of a specific 
end host), the subnet list becomes empty.

Workaround:

None.

CSCdv18014 UTlite process utlite.exe does 
not terminate after running.

UTLite process utlite.exe does not terminate after 
utlite runs on a workstation and sends the data to 
cw2k server.

Table 5 Topology Services Known Problems

ID Summary Explanation

None OAM Ping is only supported if 
ATM Switch Processor version 
is 4.0 or above for devices with 
FC-PFQ card.

If a device has an FC-PFQ feature card, OAM 
Ping is supported only if ATM Switch Processor 
version is 4.0 or later.

Workaround:

None.

None The supported ILMI 
configuration interface types are 
UNI, PNNI, and IISP.

In ATM Management Interface Configuration 
window, the only supported choices for ILMI 
Configuration Interface Type are UNI, PNNI, and 
IISP.

Workaround:

None.
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None Multilayer Switch Module 
gigabit ports displayed as 
unknown-duplex.

Multilayer Switch Module does not have the MIB 
to support half- and full-duplex on gigabit ports. 
Therefore, those ports are displayed as 
unknown-duplex.

Workaround:

None.

CSCdp47638, 
CSCdp47670

After a port change, both the old 
and the new link are displayed.

After a link is changed to a different port on same 
device, both old and new links appear. Instead of 
being displayed as a dashed red line, old link 
remains a solid red line.

Workaround:

Delete all links originating from both devices and 
rediscover the two devices.

CSCdp69800 Correct last fail cause not shown 
for LAN Emulation client.

If you select Diagnosis> LE Client> LE Client 
Status, last fail cause shown for a LAN Emulation 
client is cause reported by LAN Emulation server. 

Workaround:

None.

CSCdp88318 Link attributes are not updated 
after a change is made.

If you change link attributes, ANI Server does not 
properly discover and display change in reports. 

Workaround:

To update link attributes, close and relaunch 
Topology Services.
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CSCdr11577 Virtual Circuit (VC) error chart 
is blank.

A blank chart could mean either a continuous 
polling failure or a failure due to other problems. 

For example, a blank VC error chart might be due 
to a continuous polling failure (of VC error related 
data) or because these statistics might not be 
supported on certain image versions of ATM 
switch being polled.

Workaround:

None.

CSCds01210 Delete VLAN window remains 
open after a VLAN is deleted.

Following actions result in a problem:

1. Launch Topology Services.

2. Delete an existing VLAN. "Operation 
successful" dialog box appears.

3. Click OK.

Delete VLAN window does not close as expected. 
Busy icon is displayed, and user is unable to 
perform any operations within window.

Workaround:

Use Window close button to close.

CSCds61359, 
CSCds71941

Unable to select main topology 
window from Window menu.

The following actions result in the problem:

1. Launch Topology Services.

2. Open Layer 2 topology map.

3. Select main topology window from Window 
menu. The main topology window is not 
selected.

Workaround:

None.
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CSCin01977 Position of devices connected to 
SwitchCloud changed after 
upgrade.

Switch clouds and fabrics represent the collection 
of LAN switches and ATM switches respectively. 
These logical entities are very specific to the 
currently discovered network i.e if there is a new 
switch discovered it can affect either of them to a 
very large extent. So uniquely identifying a switch 
cloud/fabric across ANI databases is not possible 
by current mechanisms.

Workaround:

None.

CSCdt00478 Printing display view map from 
Topology Services sometimes 
results in errors.

Labels may not be printed properly if display view 
map is printed with Labels option selected. 

Workaround:

None.

CSCdt21487 When the topology map of a 
large network is exported to 
Visio, an illegible Visio file is 
produced.

Export topology map of large network into Visio 
and open resulting file. Device icons are 
positioned haphazardly and are difficult to make 
sense of.

Workaround:

Do not export entire topology map to Visio. 
Instead, select and export particular devices or 
segment of network.

CSCdt27824 Entire list of ports in a VTP 
domain is displayed when 
certain Transparent VTP 
domains are selected from 
VLAN Assignment dialog box.

When similar VLAN definitions exist on a VTP 
server and transparent devices, VLAN is added 
under parent folder and all transparent devices. 
Thus, VLAN ports are displayed under all 
transparent devices.

Workaround:

Run Find Ports query and enter device 
name/address to view ports for that device.
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CSCdt28061 Unable to view map displaying 
highlighted device in Trace 
Report window.

The following actions result in the problem:

1. Install Campus Manager 3.2.

2. Click Display VCs Per Device.

3. Select device and click Get Info. All VCs in 
device are displayed.

4. Select a VC and click Trace Report.

5. In Trace Report window, click Highlight 
Map. Map displaying highlighted device is 
not launched.

Workaround:

None.

CSCdt33558 ICS System Manager does not 
launch from Topology Services 
context menu.

With Topology Services running in Internet 
Explorer browser, if you select ICS System 
Manager from context menu, it does not launch. 

Workaround: 

1. Open new Internet Explorer browser and 
type device IP address as URL— 
http://device_ip_address.

2. Launch ICS System Manager from Topology 
Services running in Navigator browser.

Table 5 Topology Services Known Problems (continued)

ID Summary Explanation
33
Release Notes for Campus Manager 3.2 on Solaris

78-14011-02



 

Known Problems
CSCdt50396,
CSCdt51095

Display VC Per Device window 
unusable after selecting a row 
and clicking Get Info.

The following actions result in a problem:

(Scenario #1)

1. Launch Display VC Per Device window.

2. With all VCs highlighted, select a device/port 
and click Get Info.

3. After Get Info button becomes active again, 
select a different device/port.

4. Select one of the displayed rows and click Get 
Info.

(Scenario #2)

1. Launch Display VC Per Device window. 

2. With all VCs highlighted, select a device/port 
and click Get Info. 

3. Before Get Info button becomes active again, 
select one of the displayed rows. 

Exception is returned in Java console, and Display 
VC Per Device window becomes unusable.

Workaround:

Close and relaunch Display VC Per Device 
window.

CSCdt50619 Two devices, connected by 
multiple links, appear to be 
connected by only one link.

When two devices are connected by multiple links, 
deleting and then rediscovering either devices or 
links causes all links to be stacked on top of each 
other. Consequently, devices appear as if they are 
connected by only one link.

Workaround:

Do a relayout.
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CSCdv00136 VLAN management always adds 
VLAN 1 to trunk.

If the trunk is not forwarding traffic for VLAN 1 
(VLAN 1 is not added to the trunk) and you add 
any other VLAN, such as VLAN 7, to the trunk, 
VLAN 1 will also be added to the trunk, although 
it was not included in the add operation. This 
problem occurs whatever the CatOS version 
running on the switch.

Workaround:

This has been fixed in the CatOS 6.3 version. 
Upgrade to this version

CSCdv21768 Discrepancy Report missing 
detail for C6509 v5.4.

The Campus Manager Discrepancy report does not 
include trunking information under the "Detail" 
for a C6509 running Cat OS 5.4.

Workaround: 

None

CSCdv41860 Topo Map: Fetching LANE 
components details gives 
AniSQLException.

In Topology Services, If you create a LANE 
component in an atm switch(LS1010) and launch 
its view, all the Profile and Diagnosis menu items 
related to this component throws exception and 
displays the error message "Internal error"

Workaround:

None

CSCdw66262 ANI does not show devices using 
sysName.

ANI does not show discovered devices using 
sysName even though sysName is defined. 

Workaround:

Install CM32.IDU.v2-0.sol.tar.Z available at 
http://www.cisco.com/cgi-bin/tablebuild.pl/cw20
00-campus
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CSCdw49136 A break in connection between 
LANE and VLAN.

When the LEC from the Catalyst is removed the 
connection between ATM-VLAN and VLAN is 
broken for 2900XL devices. This bug is due to the 
bug in the 2900XL agent devices wherein the 
CISCO-LEC-EXT-MIB is not supported.

Workaround: 

None

CSCdw78798 Campus Map does not print well 
for a large map > 180 devices.

Campus Manager has about 180+ devices on the 
Layer 2 Map. If the customer uses the Print All 
option, it prints the map on one page but the font 
size is too small and un-readable.

Workaround: 

None

CSCdw83624 ANI does not support more than 
2GB physical memory.

ANIServer runs out of memory when server has 
more than 2GB physical memory.

Workaround

Reduce the amount of physical memory to 1GB.

CSCin00665 TOPO: Voice Port information 
not shown for C4224 images up 
to 12.1(5)YE3.

This is due to a bug in the agent and the bug id is 
CSCdu08256.

This has been fixed in the images after 12.1(5)YE3 
Upgrade to this version.

CSCin01451 Cannot launch Customer 
Response Application URLs 
from Service Attributes window.

The sysApplInstallPkgLocation MIB object 
returns /AppAdmin/ where as 
http://ip-address/AppAdmin cannot launch the 
application as the application web server was 
running in a different port 6293 

Workaround:

Use CRA version 3.0(0.25) and higher to avoid 
this problem.
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CSCdw19557 LANE: Peer Host and elan not 
shown for backup peers (LES).

1. In a VTP domain map of the atm-vlan, select 
a switch that has LECS configured.

2. Invoke Diagnosis > LE Config Server > 
Control Connections.

3. Open Config Server control Connections for 
host.The list of control connections does not 
show the peer host and elan name. 

Workaround:

None.

CSCdw19584 VLANE: Error on invoking LES 
status whose mastership is 
unknown.

Invoke VTP domain map of the atm-vlan and 
select a switch that has LES configured whose 
mastership state is unknown.

From the map, Select Diagnosis > LE/BU server > 
LE Server Status. This gives an Exception. 

Workaround: 

None

CSCdw20967 VLANE: Missing info in Client 
ARP Information window.

1. Create ELAN, LECS, LES, a backup LES and 
LEC.

2. Select the ATM-VLAN, invoke view of the 
ATM-VLAN

3. Invoke VTP domain map of the ATM-VLAN.

4. Select a switch that has LECS and LEC 
configured.

5. Select Diagnosis > LE Client > ARP 
Information

This list shows all information for other clients in 
the same device, but does not show Host and 
Interface in other devices. 

Workaround: 

None.
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The following table lists the problems resolved since the last release of Campus 
Manager.

CSCin06940 All 3550 flavours shown as 
Switch in Topo and as Router in 
Path.

All 3550 devices supported in Campus Manager 
3.2 are shown as Switch in Topology Services and 
as Router in Path Analysis. 

Workaround:

Install CM32.IDU.v2-0.sol.tar.Z available at 
http://www.cisco.com/cgi-bin/tablebuild.pl/cw20
00-campus

CSCin08530 3550: Cannot assign Fast 
Ethernet ports to VLANs

Could not assign Fast Ethernet ports to VLANs 
using VLAN Port Assignment for 3550 devices.

Workaround:

None.

CSCin08900 3550: Port Attributes - Port Type 
is shown as other

Port Attributes shows the port type as other for 
certain 3550 device flavours. 

Workaround:

None.

CSCdv42025 Cannot open Campus map on 
Visio 2002

Export of Campus Manger map to microsoft visio 
2002 fails.

Workaround:

Export map to visio 5 or 2000 and then open the 
file in visio 2002
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Table 6  Resolved Problems

ID Summary

CSCdt06568 Layer 2 not shown from end 
station to HSRP router.

When a trace is done between the end-host and 
HSRP Virtual router, Path Analysis shows 
intermediate Layer 2 information correctly.

CSCdt26665 A line of text printed from 
most Topology Services 
dialogs that exceed the width 
of the page is truncated.

This problem has been resolved.

CSCdu14078 User Tracking does not age 
correctly.

User tracking is able to detect the change of IP 
address, VLAN and subnet information.

CSCdu32808 Campus Manager cannot get 
all detailed discrepancy 
reports exported into one file.

This problem has been resolved.

CSCdu69142 UT unable to discover hosts if 
multiple subnets are in same 
VLAN.

This problem has been resolved.

CSCdu84069 Physical Discrepancy Report 
shows MSFC port, i.e. 15/1 
and 16/1, has portfast enabled

This problem has been resolved.

CSCdv00632 Capability to sort using 
multiple keys is not present in 
CM 3.1.

The multiple sort feature has been added. An 
additional option has been added to Advanced 
Query tab which provides sort feature for both 
main table and phone table.

CSCdv12524 User Tracking PortName does 
not read correct object for 
CatOS/IOS

This problem has been resolved.

CSCdv18629 User Tracking may show 
duplicate devices on 
channeled trunk links

This problem has been resolved.
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CSCdv40526 User Tracking should 
dynamically update host 
changes (DHCP env)

User Tracking is able to detect the change of IP 
address of an end-host. (In ANIServer, properties 
set UTIPChange=1) 

However, when the end-host moves to a different 
VLAN (say across subnets) that normally leads to 
a change of IP address and when UTIPChange 
parameter is set to 1, IP address change is 
sometimes not recognized. (

CSCdw 00411 User Tracking does not poll all 
discovered VLANs.

This problem has been resolved.

CSCdw04677 Campus Manager Topology 
needs to trim domain suffix for 
sysName.

This problem has been resolved.

CSCdw68567 Cannot trim the domain 
suffixes from the sysName.

This problem has been resolved.

CSCdw73370 Cannot launch Telnet from 
Sever.

Now the application uses the telnet:// protocol 
from the browser. The browser should be 
configured properly for the telnet protocol.

CSCdw77105 Custom layout doesn't work 
via the CLI in User Tracking.

A new hash table was added to read the position of 
columns from the layout, and filter them when 
displaying data. The fix has been applied to 
createcolumnVisibilityTable function and the 
showdata function.
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Obtaining Documentation
These sections explain how to obtain documentation from Cisco Systems.

World Wide Web
You can access the most current Cisco documentation on the World Wide Web at 
this URL:

http://www.cisco.com

Translated documentation is available at this URL:

http://www.cisco.com/public/countries_languages.shtml

Documentation CD-ROM
Cisco documentation and additional literature are available in a Cisco 
Documentation CD-ROM package, which is shipped with your product. The 
Documentation CD-ROM is updated monthly and may be more current than 
printed documentation. The CD-ROM package is available as a single unit or 
through an annual subscription.

Ordering Documentation
You can order Cisco documentation in these ways:

• Registered Cisco.com users (Cisco direct customers) can order Cisco product 
documentation from the Networking Products MarketPlace:

http://www.cisco.com/cgi-bin/order/order_root.pl

• Registered Cisco.com users can order the Documentation CD-ROM through 
the online Subscription Store:

http://www.cisco.com/go/subscription

• Nonregistered Cisco.com users can order documentation through a local 
account representative by calling Cisco Systems Corporate Headquarters 
(California, U.S.A.) at 408 526-7208 or, elsewhere in North America, by 
calling 800 553-NETS (6387). 
41
Release Notes for Campus Manager 3.2 on Solaris

78-14011-02

http://www.cisco.com
http://www.cisco.com/public/countries_languages.shtml
http://www.cisco.com/cgi-bin/order/order_root.pl
http://www.cisco.com/go/subscription


 

Obtaining Technical Assistance
Documentation Feedback
You can submit comments electronically on Cisco.com. In the Cisco 
Documentation home page, click the Fax or Email option in the “Leave 
Feedback” section at the bottom of the page. 

You can e-mail your comments to bug-doc@cisco.com.

You can submit your comments by mail by using the response card behind the 
front cover of your document or by writing to the following address:

Cisco Systems
Attn: Document Resource Connection
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.

Obtaining Technical Assistance
Cisco provides Cisco.com as a starting point for all technical assistance. 
Customers and partners can obtain online documentation, troubleshooting tips, 
and sample configurations from online tools by using the Cisco Technical 
Assistance Center (TAC) Web Site. Cisco.com registered users have complete 
access to the technical support resources on the Cisco TAC Web Site. 

Cisco.com
Cisco.com is the foundation of a suite of interactive, networked services that 
provides immediate, open access to Cisco information, networking solutions, 
services, programs, and resources at any time, from anywhere in the world. 

Cisco.com is a highly integrated Internet application and a powerful, easy-to-use 
tool that provides a broad range of features and services to help you with these 
tasks:

• Streamline business processes and improve productivity 

• Resolve technical issues with online support

• Download and test software packages
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• Order Cisco learning materials and merchandise

• Register for online skill assessment, training, and certification programs

If you want to obtain customized information and service, you can self-register on 
Cisco.com. To access Cisco.com, go to this URL:

http://www.cisco.com

Technical Assistance Center
The Cisco Technical Assistance Center (TAC) is available to all customers who 
need technical assistance with a Cisco product, technology, or solution. Two 
levels of support are available: the Cisco TAC Web Site and the Cisco TAC 
Escalation Center.

Cisco TAC inquiries are categorized according to the urgency of the issue:

• Priority level 4 (P4)—You need information or assistance concerning Cisco 
product capabilities, product installation, or basic product configuration.

• Priority level 3 (P3)—Your network performance is degraded. Network 
functionality is noticeably impaired, but most business operations continue.

• Priority level 2 (P2)—Your production network is severely degraded, 
affecting significant aspects of business operations. No workaround is 
available.

• Priority level 1 (P1)—Your production network is down, and a critical impact 
to business operations will occur if service is not restored quickly. No 
workaround is available.

The Cisco TAC resource that you choose is based on the priority of the problem 
and the conditions of service contracts, when applicable.

Cisco TAC Web Site

You can use the Cisco TAC Web Site to resolve P3 and P4 issues yourself, saving 
both cost and time. The site provides around-the-clock access to online tools, 
knowledge bases, and software. To access the Cisco TAC Web Site, go to this 
URL:

http://www.cisco.com/tac
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All customers, partners, and resellers who have a valid Cisco service contract have 
complete access to the technical support resources on the Cisco TAC Web Site. 
The Cisco TAC Web Site requires a Cisco.com login ID and password. If you have 
a valid service contract but do not have a login ID or password, go to this URL to 
register:

http://www.cisco.com/register/

If you are a Cisco.com registered user, and you cannot resolve your technical 
issues by using the Cisco TAC Web Site, you can open a case online by using the 
TAC Case Open tool at this URL:

http://www.cisco.com/tac/caseopen

If you have Internet access, we recommend that you open P3 and P4 cases through 
the Cisco TAC Web Site.

Cisco TAC Escalation Center

The Cisco TAC Escalation Center addresses priority level 1 or priority level 2 
issues. These classifications are assigned when severe network degradation 
significantly impacts business operations. When you contact the TAC Escalation 
Center with a P1 or P2 problem, a Cisco TAC engineer automatically opens a case.

To obtain a directory of toll-free Cisco TAC telephone numbers for your country, 
go to this URL:

http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml

Before calling, please check with your network operations center to determine the 
level of Cisco support services to which your company is entitled: for example, 
SMARTnet, SMARTnet Onsite, or Network Supported Accounts (NSA). When 
you call the center, please have available your service agreement number and your 
product serial number.

This document is to be used in conjunction with the documents listed in the “Campus Manager 3.2 Documentation” 
section.
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